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Introduction

The Peripheral Server Remote /O Concentrator is the first remote networking solution to utilize
USB Over IP™ technology, breaking the traditional five meter distance limitation between USB
device and host. Now USB devices may be located anywhere on a wired or wireless LAN —
without a locally attached host PC. Since the host PC or server may be located remotely,
Peripheral Server enables devices to be deployed in harsh or non-secure environments, making it
ideal for point-of-sale, kiosks, surveillance, industrial automation, or any mission-critical enterprise
application. This Ethernet-attached solution provides five USB ports to connect peripheral devices
like bar-code scanners and receipt printers.

Cabling Peripheral Server

To connect the Peripheral Server Concentrator to a network:

1. Connect a standard Ethernet network cable to your Peripheral Server. Then
connect the other end of the Ethernet cable to a 10/100 BaseT switch or hub.

2. Connect one end of the power supply* into the back of your Peripheral Server and
the other end into an AC outlet.

*Power to this product may be supplied by a UL Listed Direct Plug-In Power Unit marked “Class 2" or a UL listed power
supply rated with a minimum rating of 5 V dc 2.5 A if used in the U.S. and Canada or a power supply with similar rating
and approved by your local safety code if it is used elsewhere. For polarity, see the following:

o

Installing the Drivers

For Windows XP, 2000 and NT4.0 Users
You must install the drivers using an account that has administrative privileges.
1. Insert the “Peripheral Server Driver” CD into your CD drive.

2. If the CD does not automatically start, then open the CD folder and double click on
the awbb126.exe program.

3. A welcome screen allows you to view and print this guide, install the drivers, and
check our web site for the latest information.

4, Click the “Install Drivers” button to start the install process. Then follow the on-
screen instructions to complete the installation of your Peripheral Server
Concentrator.

After installing the drivers, the Peripheral Server Configuration Uility automatically starts so that
you may configure your Peripheral Server Concentrator.
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Configuring Your Concentrator

For initial configuration, the Concentrator must be connected to the same local area network as
the configuration PC. Note also that Peripheral Server Concentrators cannot function behind
firewalls

In order to configure your Peripheral Server Concentrator:

1. Launch the Peripheral Server Configuration Utility from the Start menu. The utility
displays a list of discovered Peripheral Server Concentrators on your local subnet.
A new Peripheral Server Concentrator will have a default IP address of 0.0.0.0.
You must configure the Concentrator before it can be used on a network.

2. After the Peripheral Server Configuration Utility has been launched it will reside in
your system tray. To open the utility double click on the Inside Out Networks icon
in the system tray. If you try to start the Utility from the start menu and does not

launch, check the system tray.

‘i UsSB Peripheral Server Configuration Ukility

B 1249 PM

=10 x|

File Edit Cammand Yiew Help
EEmss ’t}
Configure Connect Ewent Log Fehoot
El--g% Unconfigured M arne: IUSE Peripheral Server
{I} USE Peripheral Server [Unconfigured]  [2eral Number: 413F0643
MAC Address:  00-20-BE-FF-0B-459
IP Address: 0000
Subnet Mazk: 0000
[3 ateway: 0000
Debug Log: 0.0.0.0
DHCP: Dizabled
Boot Code: vl 3.2
Firrmware: wl.26.1
Hardware: Few B
|l ptire: 10 zec
Status: IP Address needs to be configured

Total Dizocovered: 1

Connected To Me: 0 Available For Connection: O

Inlze: 0 Unconfigured: 1

3. You can identify each concentrator by its IP Address. If the Concentrator is
unconfigured, then the serial number can be used for identification

Unconfigured Concentrators are listed separately. For example, the Concentrator
with serial number V419F0649 above has not yet been configured.

4. To discover Concentrators on other networks, see “Using the configuration Utility

Program” on page 7.
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5. Double click on the Concentrator or select the Concentrator and press the
Configure button in order to set the IP address, subnet mask, and Gateway.

Device Name:

o |
|

Serial Mumber:

| Y419FF49

MAC Address:
| 00-20-BE -7F-06-43

|P Address:
| 0.0 .0 .0

Subnet Mazk:
| 0.0 .0 .0

Gateway:
| 0.0 .0 .0

DHEFR;
|7f" Enable: %) Disabls

[ Add to connection list

Debug Log Address:
[Optional. For technical support use only)

oo .o .0

Cloze

6. Enter a Device Name that easily identifies the concentrator.

7. Enter the IP address and Subnet Mask. Contact your Network Administrator for IP

address assignment

8. Enter the Gateway for your network. In a network using subnets, the Gateway is
the router that forwards traffic to a destination outside of the subnet of the

Peripheral Server device.

9. For the changes to take effect you must click on the Update button to reset the

Concentrator.

You will need to reboot your USE Peripheral Server to complete the configuration process.,

Would vou like o rebook now?

Yes Mo
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Configuring Your Host PC

To configure a Host PC to access the Concentrator:

1.

Launch the Peripheral Server Configuration Utility from the Start menu. The utility
displays a list of all Peripheral Server Concentrators on your local subnet. And on
any subnet configured in the Discovery List.

After the Peripheral Server Configuration Utility has been launched it will reside in
your system tray. To open the utility double click on the Inside Out Networks icon
in the system tray. If you try to start the Utility from the start menu and does not
launch, check the system tray.

=B, 1249 PM

The Configuration Utility automatically discovers Concentrators on your local
subnet. To discover Concentrators on other networks, you must add their network
address to the Discovery list. Select “Discovery List” from the “Edit” menu. Add the
Subnet addresses to the Discovery List Manager. For example, to add the Class C
network 10.21.1, you must enter 10.21.1.255. Note that your routers must be
configured to pass subnet broadcasts.

Discovery List Manager ﬂ

The Discovery Address List displays the netwark,
addrezses that will be searched for attached LISE
Peripheral Servers. If you no longer wizh to zearch a
particular network. address, then please delete it from
the Dizcovery Address List.

I | . . . Cloze

f

Dizoovery Address List; Add
b cdify

Delete

Delete Al

ElE

When you have completed adding the subnet address to the Discovery List, click
on the Close button to save the list. The screen will refresh within a few seconds.

Select a Concentrator and press the Connect button to add the Concentrator’s IP
address to the Connection List. The host computer then attempts to connect to the
Concentrator. For a list of the Concentrators to which you are currently configured

Peripheral Server Installation Guide (Rev. A) — Page 4




to connect, select “Connection List” from the “Edit” menu.

6. The Found New Hardware Wizard prompts you to search for the drivers: one time
for the Remote Hub and two times each for the USB Host Controllers and the USB
Root Hub. Select the “install software automatically” (Recommended)” option and
click the Next button. If you get the warning message indicating that the drivers
have not yet passed Windows Logo Testing. Click the Continue Anyway button.

Uninstalling the Drivers

To uninstall the Peripheral Server drivers
1. Launch the Peripheral Server Configuration Utility from the Start menu.

2. Select Preferences from the File menu and click on the Uninstall button. You
must reboot your PC in order to complete the driver removal.

Interpreting the Status Lights

The Peripheral Server Concentrator has 6 LEDs on the front panel, the System Status LED and 5
hub LEDs. Each LED is capable of displaying 3 colors, red, green, or orange.

System Status Lights

On initial power up the system status LED is orange for 2 seconds while the system initializes and
then blinks green.

Hub Lights

Green hunting pattern across all LEDs Not connected to a host.

Orange alternating on ports 1-3-5 and 2-4  Updating image in Flash. Do not remove power
from concentrator while flash is being updated.
Doing so will damage your concentrator.

Solid Green Hub port is powered

Green over Red hunting pattern Please call customer service.
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Using the Configuration Utility Program

The Peripheral Server Configuration Utility displays Concentrators grouped by subnet. The Utility
automatically discovers Concentrators on your local subnet. To discover Concentrators on other
networks, you must add their networks address to the Discovery list. Select “Discovery List” from
the “Edit” menu. Add Subnet addresses to the Discovery List Manager. For example, to add the
Class C network 10.21.1, you must enter 10.21.1.255. Note that your routers must be configured
to pass subnet broadcasts.

4 USE Peripheral Server Configuration Utility - =10 x|

File Edit Command Yiew Help

B |es===| g | ©

Configure Connect Event Log Fehboot

El--g% Unconfigured M ame: IISB Perpheral Server
{D USE Peripheral Server [Unconfigured]  [~enial Number:  413F0643

bAC Address:  00-20-BE-7F-06-49
P Address: 0000
Subnet Maszk: 0000

[5 ateway: 0000
Debug Log: 0000
DHCP: Dizabled

Boot Code; vl 3.2
Firrmware: vw].26.1
Hardware: Rev B

|l ptirne: 10 zec
Statuiz: |F Address needs o be configured

Total Dizcovered: T Connected To Me: 0 Awaillable For Connection: 0 Inlsze: 0 Unconfigured: 1

Menu Options

File Menu: Preferences

Allows you to disable or modify the frequency in which the utility updates its discovered
concentrator list. Enables the logging of driver events to the system event log and allows you to
uninstall the drivers

Edit Menu: Connection List

Contains the IP addresses of the Peripheral Server concentrators to which this Host PC will try to
connect. When an IP address is added to this list, the Host PC immediately tries to connect to the
concentrator. If an IP address in this list is deleted, all USB devices attached to this concentrator
will be removed from this Host PC.
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Edit Menu: Discovery List

Contains a list of subnet addresses of remote networks where the configuration utility will search
for Peripheral Server Concentrators.

Command Menu: Configure

Allows you to setup the TCP/IP parameters in the concentrator. You can also add this IP address
to the Concentrator Connection List by checking the Connect to this Concentrator check box.

Command Menu: Connect

Adds the IP address of the Concentrator to the Connection List.

Command Menu: Event Log

Retrieves event information from Peripheral Server Concentrator. Use this to gather information
for Technical Support.

Command Menu: Reboot

Causes the Concentrator to reboot.

View Menu: Refresh (F5)
Updates the Discovered Concentrator List.

View Menu: Driver Information

Displays the version numbers of the Peripheral Server drivers and allows you to uninstall the
drivers.
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Understanding Hubs

Hubs, critical components in the plug-and-play architecture, are wiring concentrators that enable
the attachment of multiple devices, thus converting a single attachment point into multiple
attachment points. USB architecture allows a cascaded multiple hub configuration with certain
power limitations (explained later in this section). See figure 1.

[ USB Director l
[j t] | Devlice ][II | HUB | |
000

[ Device ]

Joystiek

|
b u spowered hub ][ scanner

Figure 1: Example of a Typical Hub Configuration

Each hub has an upstream port, connecting to the host, and multiple downstream ports,
connecting to downstream devices, including other hubs. A hub can detect attachment and
detachment of downstream devices and enable and monitor the distribution of the power to
downstream devices via their integral hardware and the operating system.

Each USB device reports its power requirements to the operating system, which then enables
and disables the device as a function of its power requirements and the amount of available
power. High-speed devices typically need to be connected to a self-powered hub, which obtains
power from its external power supply and provides up to 500 mA for each downstream port. Only
simple devices, such as a mouse, can be connected to a bus-powered hub, which obtains power
from its upstream host and provides up to 100 mA for each downstream port.

Due to the limited available power for bus-powered hubs, cascading two bus-powered hubs is an
illegal topology, and devices connected to the second hub will not function. (USB specifications
limit the connection of a bus-powered hub to a self-powered hub or host only.)

According to the USB Specification, the maximum limit of hubs cascaded in series cannot exceed
five. In other words, you may have a maximum of five hubs between any device and the host.
This does NOT mean that the maximum number of hubs in a system is five. Indeed, up to seven
hubs can be connected parallel at any given level. You must tally both external and embedded
hubs when counting downstream hubs.
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